
 

UNIT 1- INTRODUCTION TO EXCEL 

 

 
1. MS-EXCEL is a part of Microsoft Office suite software. It is an electronic spreadsheet with 

numerous rows and columns, used for organizing data, graphically represent data(s), and performing 

different calculations. There are 16,384 columns and 1,048,576 rows in each Excel worksheet since 

Excel 2007. That makes 17,179,869,184 cells. 

Microsoft Excel is a spreadsheet developed by Microsoft for windows, mac os, android and ios. It 

features calculation or computation capabilities, graphing tools, pivot tables and a macro programming 

language called Visual Basic for Applications. 

Excel contains a large number of boxes called cells that are ordered in rows and columns. Data is placed 

in these cells. 

What is a cell? 

A spreadsheet is in the form of a table comprising rows and columns. The rectangular box at the 

intersection point between rows and columns forms a cell. Given below is an image of a cell: 

 

 

 

 

 

 

 

 

 

 

 

Name Range 

Name Range is the names used to refer to cell references, formula results, or values. They are often 

used to avoid hard-coded values appearing in formulas and to make formulas clearer in general. They are 

stored in what is known as the Name Manager in Excel. 



 

2. WHY ARE EXCEL MACROS USED IN EXCEL? 

As humans, we are creatures of habit. There are certain things that we do on a daily basis, every working 

day. Wouldn’t it be better if there were some magical way of pressing a single button and all our routine 

tasks are done? I can hear you say yes. Macro in Excel helps you to achieve that. In a layman’s language, 

a macro is defined as a recording of your routine steps in Excel that you can replay using a single button. 

 

For example, you are working as a cashier for a water utility company. Some of the customers pay 

through the bank and at the end of the day, you are required to download the data from the bank and 

format it in a manner that meets your business requirements. 

 

You can import the data into Excel and format. The following day you will be required to perform the 

same ritual. It will soon become boring and tedious. Macros solve such problems by automating such 

routine tasks. You can use a macro to record the steps of 

 Importing the data 

 Formatting it to meet your business reporting requirements. 

 

SORTING AND QUERYING DATA 

Sorting is the process of arranging the strings or integers so that they can be placed in ascending or 

descending order. In this article, we will look into how we can do Sorting in Excel. 

To do so follow the steps below: 

Sorting Strings: 

Step 1: Formatting data for sorting. 

Step 2: Converting data from unsorted to sorted order in ascending order. 

First, highlight the data which we want to sort. 

https://www.guru99.com/excel-tutorials.html


 

 

 

 

 

Step 3: Then, click to Data on the Ribbon. In the Sort & Filter group, click Sort. 

 

 

 

 

 

 

 

Step 4: - In the Sort box, select A to Z in order to sort the data in ascending order, then click Ok. 

 

 

 

 

 

 

 

 

 

 

Now, data are sorted in ascending order. 

 

 

 

 

 

 

 

Step 5: Now, if we want to sort in descending then we have to select Z to A in order to sort the data in 

descending order, then click Ok. 



 

Now, data are sorted in descending order. 

 

 

 

 

 

 

 

 

 

 

3. HOW TO HIDE, UNHIDE AND GROUP, UNGROUP ROWS AND COLUMNS IN EXCEL 

 

You have an Excel table with some unimportant rows, but you don’t want to delete them. In such case, 

you might want to “hide” them. There are two options of hiding rows (and columns): Either right-click on 

the row (or column) number and click on “Hide” or use the grouping function in order to create a group. 

 

HIDE FUNCTION 

Many people love the “Hide” function for hiding rows or columns, because it is very easy to use: (the 

numbers are corresponding with the image) 

1. Mark the row(s) or column(s) that you want to hide. 

2. Right-click on the row number or column letter and click on “Hide”. 
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Unhide (all) hidden rows and columns 

 

Unfortunately, hiding rows and columns has one big disadvantage: Hidden rows or columns are very hard 

to be seen. It’s only symbolized by a thin double line between the row or column number (3). A better 

way for hiding rows or columns is the Group function (4). 

 

4. CELL REFERENCING 

 

A cell reference refers to a cell or a range of cells on a worksheet and can be used in a formula so that 

Microsoft Office Excel can find the values or data that you want that formula to calculate. 

 

In one or several formulas, you can use a cell reference to refer to: 

 Data from one or more contiguous cells on the worksheet. 

 Data contained in different areas of a worksheet. 

 Data on other worksheets in the same workbook. 

 

For example: 

This formula:  Refers to: And Returns:   

=C2  Cell C2 The value in cell C2.  

=A1:F4  Cells A1 through F4 The values in all cells, but you must press 

Ctrl+Shift+Enter after you type in your formula. 

 
Note: This functionality doesn't work in Excel for 

the web. 

=Asset-Liability The cells named Asset 
and Liability 

The value in the cell named Liability subtracted 
from the value in the cell named Asset. 

{=Week1+Week2} The cell ranges named 

Week1 and Week2 

The sum of the values of the cell ranges named 

Week1 and Week 2 as an array formula. 

=Sheet2!B2  Cell B2 on Sheet2 The value in cell B2 on Sheet2.  
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DATA VALIDATION 

Use data validation to restrict the type of data or the values that users enter into a cell. One of the most 

common data validation uses is to create a drop-down list. 

1. Select the cell(s) you want to create a rule for. 

2. Select Data >Data Validation. 

 

 

 

 

 

 

 

3. On the Settings tab, under Allow, select an option: 

Whole Number - to restrict the cell to accept only whole numbers. 

Decimal - to restrict the cell to accept only decimal numbers. 

https://support.microsoft.com/en-us/office/create-a-drop-down-list-7693307a-59ef-400a-b769-c5402dce407b
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 List - to pick data from the drop-down list. 

 Date - to restrict the cell to accept only date. 

 Time - to restrict the cell to accept only time. 

 Text Length - to restrict the length of the text. 

 Custom – for custom formula. 

2. Under Data, select a condition. 

3. Set the other required values based on what you chose for Allow and Data. 

4. Select the Input Message tab and customize a message users will see when entering data. 

5. Select the Show input message when cell is selected checkbox to display the message when the 

user selects or hovers over the selected cell(s). 

6. Select the Error Alert tab to customize the error message and to choose a Style. 
7. Select OK. 

 
5. Name A Cell Or Range With The Define Name Option 

 
Although the previous method is the easiest way to define a name, the Define Name option in Excel 

enables you to do more such as setting the name's scope and adding a comment. Furthermore, Excel's 

Define Name option allows you to create a name for a constant or formula. Please follow the below 

steps to name a cell or range with the Define Name option. 

 

1. Select the cell or cell range that you want to name. You also can select non-contiguous cells or 

ranges by holding the Ctrl key. 

 

2. On the Formulas tab, in the Define Names group, click Define Name. 

 

3. In the pop-up New Name dialog box, please do as follows: 
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 In the Name box, type the range name. 

 In the Scope drop-down list, set the name scope within which the name is recognized without 

qualification (Workbook by default). 

 In the Comment box, leave a comment if you need. 

 In the Refers to box, check the reference and correct it if needed by clicking the up-arrow 

button  at right and selecting a new range. Note: By default, names use absolute cell 

references. If you'd rather have a relative named range, remove the dollar signs ($) from the 

reference. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. Click OK to save and define the name. 

 

6. BASIC FORMULAS 

 

1.  SUM 

 

The SUM() function, as the name suggests, gives the total of the selected range of cell values. It performs 

the mathematical operation which is addition. Here’s an example of it below: 

 

 

 

 

 

 

 

 

 

 

 

Fig: Sum function in Excel 



Lab Name: DATA ANALYTICS LAB Reg.No: 

I MBA :: II SEM Page No: 

 

 

 

 

 

As you can see above, to find the total amount of sales for every unit, we had to simply type in the 

function “=SUM(C2:C4)” or =A2+B2. This automatically adds up 300, 385, and 480. The result is stored 

in C5. 
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2.  AVERAGE 

 

The AVERAGE() function focuses on calculating the average of the selected range of cell values. As seen 

from the below example, to find the avg of the total sales, you have to simply type in “AVERAGE(C2, 

C3, C4)”. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig: Average function in Excel 

It automatically calculates the average, and you can store the result in your desired location. 

Example: 

 

=AVERAGE(B2:B11) – Shows a simple average, also similar to (SUM(B2:B11)/10) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. COUNT 

The COUNT function counts all cells in a given range that contain only numeric values. 

=COUNT(value1, [value2], …) 

Example: 

https://corporatefinanceinstitute.com/resources/excel/functions/count-function/
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COUNT(A:A) – Counts all values that are numerical in A column. However, you must adjust the range 

inside the formula to count rows. 

COUNT(A1:C1) – Now it can count rows. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. COUNTA 

Like the COUNT function, COUNTA counts all cells in a given rage. However, it counts all cells 

regardless of type. That is, unlike COUNT that only counts numerics, it also counts dates, times, strings, 

logical values, errors, empty string, or text. 

=COUNTA(value1, [value2], …) 

Example: 
COUNTA(C2:C13) – Counts rows 2 to 13 in column C regardless of type. However, like COUNT, you 

can’t use the same formula to count rows. You must make an adjustment to the selection inside the 

brackets – for example, COUNTA(C2:H2) will count columns C to H. 

https://corporatefinanceinstitute.com/resources/excel/functions/counta-excel-countif-not-blank/
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5. COUNTBLANK 

The Excel COUNTBLANK function returns a count of empty cells in a range. Cells that contain text, 

numbers, errors, spaces, etc. are not counted. Formulas that return empty text are counted. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

6. MAX & MIN 

 

The MAX and MIN functions help in finding the maximum number and the minimum number in a range 

of values. 

 

=MIN(number1, [number2], …) 

Example: 

=MIN(B2:C11) – Finds the minimum number between column B from B2 and column C from C2 to row 

11 in both columns B and C. 

 

=MAX(number1, [number2], …) 

Example: 

 

=MAX(B2:C11) – Similarly, it finds the maximum number between column B from B2 and column C 

from C2 to row 11 in both columns B and C. 

https://exceljet.net/glossary/range
https://corporatefinanceinstitute.com/resources/excel/functions/max-function/
https://corporatefinanceinstitute.com/resources/excel/functions/min-function/
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7. DATA ANALYSIS FUNCTION 

 

1. SUMIF 

 

It will sum up cells that meet the given criteria. The criteria are based on dates, numbers, and text. It 

supports logical operators such as (>, <, <>, =) and also wildcards (*, ?). 

 

Formula 

 

=SUMIF(range, criteria, [sum_range]) 

EXAMPLE 

We wish to find total sales for the East region and the total sales for February. The formula to use to get 

the total sales for East is: 

 

 

 

 

 

 

 

 

 

 

 

 

Text criteria, or criteria that includes math symbols, must be enclosed in double quotation marks (” “).We 
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get the result below: 
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The formula for total sales in February is: 

 

 

 

 

 

 

 

 

 

 

 

 

 

We get the result below: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. SUMIFS 

SUMIFS is a function to sum cells that meet multiple criteria. SUMIFS can be used to sum values when 

corresponding cells meet criteria based on dates, numbers, and text. SUMIFS supports logical operators 

(>,<,<>,=) and wildcards (*,?) for partial matching. 

 Syntax  



Lab Name: DATA ANALYTICS LAB Reg.No: 

Dare: 

I MBA :: II SEM Page No: 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. COUNTIF 

 

The powerful COUNTIF function in Excel counts cells based on one criteria. 

EXAMPLE 

Use the COUNTIF function in Excel to count cells that are equal to a value, count cells that are greater 

than or equal to a value, etc. 

1. The COUNTIF function below counts the number of cells that are equal to 20. 

Notice the equals sign (=) is not required when constructing "is equal to" criteria. Also notice SUMIFS 

is not case-sensitive; you can use "red" or "Red", and "TX" or "tx". 

=SUMIFS(F5:F15,C5:C15,"red")// color="red" 

=SUMIFS(F5:F15,C5:C15,"red",D5:D15,"TX")// color="red", state="TX" 

=SUMIFS (sum_range, range1, criteria1, [range2], [criteria2], ...) 

example 

 

In the worksheet shown, there are two SUMIFS formulas. In the first example (I5), SUMIFS returns a 

sum of values in column F where the color in column C is "red". In the second example (I6), SUMIFS 

sums values in column F when the color is "red" and the state is Texas (TX): 

https://exceljet.net/excel-functions/excel-sumifs-function
https://exceljet.net/excel-functions/excel-sumifs-function


Lab Name: DATA ANALYTICS LAB Reg.No: 

Dare: 

I MBA :: II SEM Page No: 

 

 

The following COUNTIF function gives the exact same result. 

 

 

 

 

 

 

 

 

 

 

3. The COUNTIF function below counts the number of cells that are greater than or equal to 10. 

 

 

 

 

 

 

 

 

 

 

The following COUNTIF function gives the exact same result. 

 

 

 

 

 

 

 

 

 

 

 

Explanation: the & operator joins the 'greater than or equal to' symbol and the value in cell C1. 

4.COUNTIFS 

The COUNTIFS excel function counts the values of the supplied range based on one or multiple criteria 

(conditions). The supplied range can be single or multiple and adjacent or non-adjacent. Being a statistical 

function of Excel, the COUNTIFS supports the usage of comparison operators and wildcard characters. 

For example, given the following table, the COUNTIFS excel function can count the total number of 

products with the name “B” for the east region. The formula 

“=COUNTIFS(A2:A13,“EAST”,B2:B13,“B”)” returns 2. 
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8. HOW GOOGLE FORMS WORK 

 

1. Log into your Google account using Google Chrome Browser 

 

You’ll know you’re logged in when you 

see your image in the upper right-hand 

corner: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Once logged in, click on the set of square boxes just to the left of your picture, and select “Google Drive”. 

 

2. Once on the Google Drive page, click on “New” 
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From the dropdown, select “More”, and then click on Google Forms: 
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3. Once your Google Form opens, start by formatting your form 

 

Start by giving your Google Form a name that describes what you’re using it for. 

 

As an example, you might call it “Podcast Feedback”. You can name your form by clicking in the upper 

left-hand corner where it says “untitled form”. 

In the upper right-hand corner you have all of your settings (from left to right): 

 Add-ons (like Form Notifications) 

 Customize Theme (colors, images) 

 Preview (to view your form) 

 Settings (customized settings) 

 

Spend some time reviewing these settings and deciding how you want your form to function. 

The most important things to pay attention to here are under the Settings: 

 General 
 Presentation 

 Quizzes 

 

Under General, you’ll want to make sure you check the appropriate boxes based on your survey needs. 

For example, in the image below, no one outside of my organization would be able to fill out this Form 

(not the setting I want to have checked if I’m sending this out to my audience). 
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Under your Presentation settings, you’ll want to make sure you customized your confirmation message, 

and check any boxes that apply to how you want your Form to be shown to your users: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

I haven’t personally used the Quizzes settings for anything up to this point; however, if you’re interested 

in creating a quiz with point values, this is the section where you’d set that criteria: 
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4. Add your first question by typing it in the “Untitled Question” box 

 

When adding your questions, be sure to consider things like: 

 

 Do I want to collect email addresses so I can follow up with those who submit the Form? 

 Do I need any other geographical data to help inform my survey? 

 Should I be adding in any description text to help my users better understand the question? 

 Do I want all (or some) of my questions to be “required”? 

You can select different types of questions using the dropdown just to the right of the question box, and 

you can dictate whether the question is required or has a description using the settings below the question 

box: 
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5. Add multiple questions to your Google Form 

 

You can add multiple questions to your form (recommended for best engagement and survey results) by 

clicking “Add Question” to the right of your form: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

This is also where you can add images, videos, and change the text of your questions. 
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6. Select your Form sharing options (add collaborators) 

 

Once you’ve finished entering all of your questions, be sure you have the sharing options set if you want 

to have collaborators on your Form. 

You can do this by clicking on the 3 dots in the upper right-hand corner (next to your overall Form 

settings), and then selecting Add Collaborators: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Once the sharing options open, you can choose to share the link with collaborators or send them a 

message directly letting them know you’re sharing your Form with them. 

Note: if you choose to share the link with collaborators, be sure you click on the “Change…” link to 

allow others access to your Form: 
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7. Preview and share your Google Form! 

Now it’s time to preview and share your Google Form with your intended audience! 

It’s always important to double check your Form settings and appearance, so be sure to “Preview” your 

Google Form (using the eye icon in the upper right-hand corner) and test it out before sharing it with the 

public. 

Once approved by you, click on the “send” box in the upper right-hand corner and choose how you will 

share your Form: 

 Email it automatically to contacts 

 Link to it manually in an email, blog post, or on social media 

 Embed it on your website 

 

8. Review responses 

 

As you continue to promote your Form and receive feedback, make sure you’re checking it regularly! 

 

You can view a summary of your responses straight from your Google Form, or you can also choose to 

have a Google Spreadsheet created with your responses: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

9. FILTER IN EXCEL 

Filter your Excel data if you only want to display records that meet certain criteria. 

 

1. Click any single cell inside a data set. 

2. On the Data tab, in the Sort & Filter group, click Filter. 

 

 

 

 

Arrows in the column headers appear. 
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3. Click the arrow next to Country. 

4. Click on Select All to clear all the check boxes, and click the check box next to USA. 
 

5. Click OK. 

Result. Excel only displays the sales in the USA. 
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6. Click the arrow next to Quarter. 

7. Click on Select All to clear all the check boxes, and click the check box next to Qtr 4. 

 

 

 

 

 

 

 

 

 

 

 

8. Click OK. 

Result. Excel only displays the sales in the USA in Qtr 4. 

 

 

 

 

 

9. To remove the filter, on the Data tab, in the Sort & Filter group, click Clear. To remove the filter and 

the arrows, click Filter. 

 

 

 

 

There's a quicker way to filter Excel data. 

10. Select a cell. 
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11. Right click, and then click Filter, Filter by Selected Cell's Value. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Result. Excel only displays the sales in the USA. 
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